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Exploring Materials with Nanomaterial Mechanics Explorer Structure Files  
 
The Nanomaterial Mechanics Explorer https://nanohub.org/resources/nanomatmech/ is a set 
of molecular dynamics simulations that enables exploration of dislocation motion, crack 
propagation, plastic deformation, melting, and martensitic transformation.  Ready-to-run 
example files are available in the default view, and by selecting the Advanced option, the 
simulation input parameters can be seen and varied to enable exploration.  The simulations 
are run on remote servers, and the results are returned to the local computer and include 
beautiful structure visualizations and animations that can be manipulated from within the 
simulation window.  These live simulation sessions can be shared with individuals or groups 
on nanoHUB, so multiple people in remote locations can simultaneously view the progress 
and results of a specific simulation run. 
 
The simulation output files that are used to create the visualizations on nanoHUB include the 
x,y,z coordinates of each atom, at each saved step of the simulation.  These structure files 
can be downloaded, saved, and viewed with other visualization applications.  A popular tool 
is the OVITO Open Visualization Tool http://www.ovito.org/ which is free and simple to install 
on your local computer. 
 

OVITO is a scientific visualization and analysis software for atomistic simulation data 
developed by Alexander Stukowski at Darmstadt University of Technology, Germany. 
The program is Open Source and freely available for all major platforms. It has served 
in a growing number of computational simulation studies as a useful tool to analyze, 
understand, and illustrate simulation results.  

 
This document describes how to generate and download simulation output files from 
nanoHUB and view them using OVITO. 

Creating a nanoHUB Account 
To run a simulation on nanoHUB, you need to have a (free) user account.  To create an 
account, go to the nanoHUB home page, https://nanohub.org,  and click on the Sign In 
button.  There are 5 sign in options.  If your institution is already part of the InCommon 
Federation for HIgher Education, then you can sign in with the same credentials you use at 
your institution.  You can also use Facebook, Google, LinkedIn or just create a local account 
by filling in all of Login Information fields. 
 
Once you have responded to the confirmation email, you can log in to your nanoHUB 
account. 
 
If you need help with this process, or anything else you do on nanoHUB, click on the Need 
Help? link in the upper right corner of the window. 
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Generating Simulation Output 
Go to the Nanomaterial Mechanics Explorer https://nanohub.org/resources/nanomatmech/ 
and click the black button that says Launch Tool to start a simulation session.  You will be 
given a session number, which is in the URL.  Copy and paste the URL somewhere in your 
notes for reference.  For example the URL for session number 942294 looks like this: 
https://nanohub.org/tools/nanomatmech/session?sess=942294. 
 
You will also see some information about the session in the top of the window: 

 
 
In the light grey bar, you can see the session number (Session: 942294), Tool name 
“Nanomaterial Mechanics Explorer”, and time that the session was started (12:18 pm).  The 
tool name and time are also shown in the black bar.  Write down this time in your notes. 
 
You can select any of the simulations, and make changes in the input parameters.  This 
example will use the main default simulation, which is a tensile test on a [100] Nickel 
Nanowire. 
 
Information about the input parameters is given in the white text box (nanowire dimensions, 
orientation, strain rate, temperature).  Launching this simulation just requires one click, on the 
“Simulate” button.  To view or change parameters for the Ni [100] Nanowire simulation, or 
any of the simulations, click on the Advanced Options? selector. 
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Downloading Nanomaterial Mechanics Explorer structure files 
Individual structure files are labeled as trajectory “dump” files, and stored within a “sessions” 
folder in nanoHUB.  The file structure starting from your personal directory is: 
/data/sessions/[session number folder]   For this particular session, the path is: 
/data/sessions/942290 
 
Once your session has expired, “-expired” will be appended to the session name; your data 
will still be available until you clean up the space.  There are a few different ways to access 
your simulation output data in nanoHUB, as follows. 

Using WebDAV to access your nanoHUB Files 
WebDAV allows you to access your nanoHUB files with a graphical browser that lets you 
drag and drop multiple files and folders between your local computer and your account on 
nanoHUB. Instructions for using WebDav to access your nanoHUB Files are available here: 
https://hubzero.org/documentation/2.0.0/tooldevs/accesshomedir.webdav  
 
While you can browse your files by typing https://webdav.nanohub.org/webdav 
in a browser address bar, the interface is not ideal.  Use one of the following methods to 
more easily access your nanoHUB files. 
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Connecting via a Macintosh 
From the Finder, select Go, and then in the drop down window, select Connect to Server… 

 
 
In the Server Address box, enter https://webdav.nanohub.org/webdav/ .  
 
To save this Server address to your list of Favorite Servers, click the + button. 
 

 
 
 
In the next window, type in your own nanoHUB Login ID and your nanoHUB password and 
then click the Connect button. 
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Connecting via Windows 
This example is For Windows 7, instructions for other Windows versions are online in the 
HUBzero documentation. 
 
From the Start Menu, Right-Click on Computer and select Map network drive... 

 
 
Select a letter for the connection.  I choose N for nanoHUB.  
 
Enter the server address: https://webdav.nanohub.org/webdav/  . 
 
Click Finish. 

 
 
Note that the URL shown in the 
screenshot image is the old one- use 
the correct URL provided in the text: 
https://webdav.nanohub.org/webdav/ . 
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Organization of Your Files in nanoHUB 
Once you have connected via webDAV, you will see the main directories, or folders, in your 
root directory on nanoHUB.  If you see the folders that begin with a dot, ignore those. 
 
Your simulation output will be in the Sessions and Results folders, in the Data folder. 
 

 
 
Each session that you launch creates a new sessions folder.  If you will be downloading the 
output to work with on your local computer, it is a good idea to run only one simulation per 
session, so that the numbering is easier to keep track of. With this simulation tool, when you 
run a second simulation job in the same session, it will overwrite the files from the first 
simulation. 
 
Data from your current sessions and your expired sessions will be available until you reach 
your disk quota.  For example, here are three current sessions and 4 expired sessions: 
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Inside the session folders will be LAMMPs trajectory dump files from the simulation run.  
Let’s look at  the contents of the folder for session 942294: 
 

 
 
The structure data we want is in the trajectory.n.dump files.  The trajectory files are 
structure files that were saved every 1000 steps of the simulation.  Taken together, they form 
a sequence showing the structure over time. In this example, there are 26 trajectory files. 
 
In addition, there are a few other files. 
 
log.lammps includes information about the file that was run.  In this session, the file 
nanowire_Ni.data was used to run the Ni nanowire.  Here is the beginning of the log.lammps 
file: 
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in.LMP_user contains the input file for the simulation: 

 
 
Save the session folder to a location on your computer, you can drag and drop the folder to 
make a copy. 
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Opening Structure Files in Ovito 
 
Launch Ovito on your local computer. From the File dropdown menu, select Load File. 
 

 
 
Navigate to the session folder, and select trajectory.0.dump.  Click Open. 
 

 
 
This will load ALL of the trajectory dump files from this session into OVITO.  
 
OVITO also has the ability to directly load remote files. 

Loading Remote files into OVITO 
From the File dropdown menu, select Load Remote File: 
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Type in the path to the trajectory.0.dump file in the session folder you are interested in: 
sftp://yourusername@nanohub.org/home/nanohub/yourusername/data/sessions/942290/trajectory.0.dump 

 
 
Replace the text in red with your nanoHUB username and your session number. 
 
Ovito will start connecting to the remote host (nanohub.org) and ask you to enter your 
nanoHUB username and nanoHUB password to access your files. 
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Viewing Files in OVITO 
 
Once you have loaded the trajectory.0.dump file, your OVITO window will look like this: 

 
 
You can see views of the nanowire along the z (Top view), y (Front view), and x (Left view) 
axes, along with a perspective view.  In each of the 4 windows, the nanowire image can be 
rotated, panned and zoomed. 
 
OVITO has many visualization capabilities, as well as analysis tools and modifications that 
can be made to the structure.  There are 4 tabs in the control window on the right edge of the 
viewer with many options to explore.  This document will discuss just a few of the many 
options available.  Detailed instructions for using OVITO are available in the OVITO user 
manual:  http://www.ovito.org/manual/.  
 
Since we will be looking at a tensile test, we are interested in the local coordination of atoms, 
in slip planes and in dislocations.  
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In the menu on the upper right, select dislocation analysis (DXA) from the Add 
modification… drop-down menu. 

 
 
The view will change: 
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Take a closer look at the Display options and Analysis information in the right side window: 
 

  
 
Since this is a Nickel nanowire, most of the atoms are in FCC positions, as Ni has the FCC 
crystal structure.  The surface atoms, however, are not fully coordinated, so are colored as 
“other”. 
 
Note that the atom Count can give you an idea of the surface to volume ratio in this 
nanowire.  This nanowire has 2970 surface (other) atoms and 8345 interior (FCC) atoms. 
 
In the Dislocation analysis results window, there are no dislocations in the nanowire at this 
initial timestep. 
 
To see how the nanowire evolved through the whole simulation, click the triangular Play 
button at the bottom of the window: 
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Notice that in the beginning frames, you see elastic deformation, and also the displacements 
of the atoms that would allow Poisson’s ratio to be calculated.  In later frames, dislocations 
form and move, and planes slip.  
Here is a top image of the nanowire in step 12  (12000). 

 
 
You can change the background display color of the image 
you want to save using the Render menu (second tab.)  
 
Make your selections, for example set the background to 
be transparent, render the complete animation or a single 
frame, save to file.  Click on one of the 4 views you are 
interested in, and then Render Active Viewport. 
 
Here is the newly rendered output for slide 25:

 
For this slide, the Structure analysis results show that there are 3754 other atoms, 5038 
FCC atoms, and 2503 HCP atoms.  Atoms with a local HCP coordination are due to partial 
dislocations, and are found on either side of a slip plane.  This coloration makes it much 
easier to see where the slip planes are. 
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The Dislocation analysis results show that there are now 4 “other” dislocation segments, a 
½<110> Perfect dislocation, and six ⅙<112> Shockley partial dislocation segments, with the 
lengths shown. 

 
In order to see these dislocations more clearly, the Particles can be de-selected from the 
display by unchecking the box: 

 
 
Render the active viewport again:  There is a very small gap between two of the end-to-end 
“other” dislocations, so it may look as though there are only 3 of them instead of 4. 

 
Three of the shorter Shockley partial dislocations (green) meet at a point, which is also the 
end of the short perfect dislocation (blue). 
 
Another way to inspect what is going on within the nanowire is to Slice it.  Select the 
particles again to view them, and under the Add Modifications window, select Slice. 
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Setting the X, Y, and Z Normals, and adjusting the Distance, you can orient the slice plane 
the way you want, and then move it through the nanowire.  The dislocation visualizations are 
still in place, so you can see how the atom arrangements change around the dislocations. 
 
You can also make a slice with a thickness to be able to move a plane of one or two atom 
thickness through the nanowire and dislocations.  This is just a simple default slice, you might 
prefer aligning the slice along a close-packed plane. 
 

 
 
There are many more options in Ovito; these instructions should be enough to get you 
started. 
 
Many thanks to Mitch Wood and Sam Reeve in the MSE Department at Purdue for guiding 
me through this process and providing helpful feedback on this document. 
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